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Selecting a frame

How to select a frame

There is no part of the Kinovea
manual that instructs students how to
select a frame. After importing a
specific video, students can start
playing the video while paying really
close attention to the motion in the
video and hit pause at the frame of
interest. In the picture to the right,
there is a long green line with a vertical
black line which shows the time mark
(as indicated).

Leaving the video in still motion,
the “go to previous/next frame” button-
which lies next to the play button-
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allows students to manage frames in slow motion. With this method, one can select the
exact frame or moment of interest (see the red boxes

below).

From that frame, the student can now count how
many frames forward she/he is going to need for the data
export out to Excel. For example, the students can click the
“go to next frame” button 10 times which corresponds to 10
frames. Now we can scale down the total frames by
dragging the blue box at the end of the green line to the left
to where the black line is. As shown below, the green line
has decreased significantly. Now we can drag the blue box

at the beginning of the green line to the right. The duration below the green line notes the
numbers of frames in total. For instance, a duration of 0:00:00:20 indicates a total of 20
frames, so we will drag the blue box in accordance to our requirement.
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More detail on selecting frames - from starting the program to tracking

= stan
1. Click the button on the bottom left-hand corner of the screen.

L Programs

»
2. a.Move the mouse arrow to . The symbol will turn blue and programs

available will be displayed.

@) Kinovea

b. Move mouse arrow over . The Kinovea program will be shown.

@ Kinovea

d. Click @ Kinovea and the Kinovea program will open.

Fig 1: After 2a-c your screen looks like Fig 2: After you click on Kinovea your screen
this: looks like this:

) AbsoluteFTP

1) Accessories

I Microsaft Office

) Mozilla Firefox

@r

@ sas

@) startup

(%) Apple Software Update
icrosoft Update @ Internet Explorer
I/ Google Earth
E Adobe Premiere Elements 9

v @ UninstalKinovea

SecureCRT 5.2

Programs
Settings
) Help and Support

Run...

3. Videos that can be edited on Kinovea will appear in the Kinovea window (see Fig 2
above). Click on the appropriate video. The video will enlarge to take up the whole
Kinovea window.

COVeo “snrR

4. a.Pressthe = Play button to play the video. The place in the video will be shown as a
black line on a green track.
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Black line

Ag® .,/ +pbOAa@pyp:ts |
& H)|

Start :0:00:00:00 Duration :0:00:01:65

Fe 9
)

b. Move the - *  blue speed marker back and forth to change the
speed at which the video is played so that you can select the segment of the video that
you want (see step 5 below).

5. Determine which segment, or frame set, you want. The frame set consists of the frames
you want.

6. Press  to stop the video at the beginning of your frame set. Click on & at left
side of the green track and drag it to where the black line is.

Click here
\‘
-
@ g
Start :0:00:00:00 Duration :0:00:01:65

This is no longer in your
frames set.

and drag the blue marker towards

This is in your frame set.

®

Start : 0:00:00:18 Duration : 0:00:00:50

7. Press  to stop the video at the end of your segment/frame set. Click on 3 at right side
of the green track and drag it to where the black line is.

Click here

and drag towards 0
! D | ==
These are the frames you
selected

——— i_____F_,ﬂ—-ﬂ‘_ -‘--_._,__H_‘___ ﬁ
(S| ) . -

This is not in your  ration :0:00:00:36 -Srg:gl;';]_"gn?(]t in your

segment

8. You have now chosen your segment/frame set.
—

Options

9. Clickon at the top of the Kinovea window.
10. a. Move the mouse arrow to ™™ =™ * ' The symbol will turn yellow and options

will be displayed.
b_ C“Ck on | Classic + Frame numbers ”

c. You screen will look like
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File Edit View Image Motion Help

Explorer | & Shortouts Q Language »
Time markers format » | Classic (h:mm:ss:hundredth)
Folders: =
[E) Software Update... Frames Numbers
@ Desktop S 5 |
* .} My Computer o b@; Classic + Frame numbers

# Recycle Bin
[#-{5) Adobe Premiere Elements
#{3) Encoded Files

You have now chosen your settings.
11. Right-hand click on your video. You will see:

Track Path
Set Original Speed...

Save the Current Image to File

Close This Screen

Click on I Track Path . You have now told Kinovea to track the motion of an object. See
other references for more information on tracking a path.

12. (Similar to steps 1-2 and steps 9-10). Click on [ Fie l, then |[_ Setiomeainen

[ xem

'], and
See additional references for more information on exporting data.

File | Edit View Image Motion Options Help

| Open Video File... Ctrl+0 ye55_Linda plane. MP4
Recent >
Close

| Save.. Ctrl+s =
Export to Spreadsheet »

OpenOffice Calc (ODF)

Load Key Images Data. .. Microsoft Excel (MS-XML)

Quit [ xmL

3} 5 VIROLOGY IS BOMB.Dat

u Trajectories to simple text
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How to set and change the working zone

1.

Open Kinovea

In the left top corner of the screen, left-click on the “File” button

In the pop-up window, navigate to the desired video. By selecting the file and clicking on
“Open” button, Kinovea will import selected video. A small pop-up window will automatically

show up with “importing frames” processing bar.

Decompressed Fuaves | 193/ ~200

a.
b. Once the whole video will be imported, the processing bar will disappear and the

selected video will appear in the main Kinovea window.
At the button of the screen, there is a player controls.

5 I ] & G

‘Working Zone: Start : 0:00:00:00 Duration : 0:00:42:30

QU:DD:DO:UD Speead : 100

W W W W w2

3

Indicated above, these are the main buttons to navigate around the video. The button that looks
like a small green capsule
Among them, there are 4 buttons grouped together as “working zone”. They are indicated on
the image below.
A working zone defines a set of frames in which any type of “work” (such as adding effects, text,
line, etc.) can be done. Working zone can be set equal to or less than the duration of the whole
movie.
A working zone is set using two key buttons, “set the first frame of the working zone to the
current frame” !, and “set the last frame of the working zone to the current frame” ' .
To set the first or the last frame to any frame in the movie, use navigation bar to get to the
desired frame and click on “set the first frame of the working zone to the current frame”.
Once the working zone is set, there are 3 basic actions that can be done next

a. Click on “Lock working zone boundaries” to lock working zone to the selected frames.

. i 1 |* H
/v ‘Working Zone: Start : 0:00:00:00 Curation @ 0:00:42:30
QU:UD:UU 00 Speed :100% - & o+

W W YWY W Ww|2

b. You can change or working zone by click on either ends of it and literally dragging the

ends to the desired frames by pressing and holding either & or ™ .
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c. By clicking on this button, working zone resets to the length of the full video

¥ « @&
‘Working Zone: Start : 0:00:00:00 Duration : 0:00:42:30

(&5 0

—Pesithere20:00:00:00  Speed : 100%  — ) R

W WY W w2

i.
d. Note that after each manipulation with the working zone “importing frames” processing
bar will appear while Kinovea is processing the changes.

BURRRRARRRRRRRRRRRRRRRn
Decomprersed Frames | 193/ ~200
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How to select a specific number of frames in a working zone

1. Default setting displays movie in hour: min: seconds. To change to frames, click on Options
tab—> Time markers format - select Frame Numbers

File Edit View Image Motion Help

Explorer ‘ =% Shortcuts

quage >

Time markers Format 4 [ v | Classic (h:mm:ss:hundredth)

Software Update... Frames Numbers

Folders:

Desktop
j My Computer
2/ Recycle Bin —

@
@

] Classic + Frame numbers
Preferences...

Video Files:

EA2/ +pO Ay

[ 1 1« @
‘Working Zone: Start : 0:00:00:00 Duration : 0:00:03:35

Fosition :0:00:00:03  Speed : 12% o M 4

WY WwWww =

2. To obtain the correct desired number of frames, locate the beginning of the working zone by
clicking the | icon on the first frame of the working zone, and ending the working zone by
clicking the 1. In order to obtain X number of frames, watch the position located at the bottom
left of the Kinovea screen as the video is played back, ending the working zone when the

position value is the correct number of frames. (adjusting the speed to be slower is usually
necessary)
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NS E A2/ +« pQO @,p:s
201 e Q|

‘Working Zone: Start : 8 Duration : 195

&5

Position: 1 Speed : 12X  — 4%

W W W W Ww =
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Selection of 10 frames around a target frame using a key frame

1. Find the target frame with navigation cursor (marked with red rectangle below).
« @&

YWorking Zone: Start : 1 Duration : 151

LSI;IOI’I 13 Speed:1003%

W S W W W &

3

2. Once you find the target frame, click on Add a Key Frame (marked with red rectangle
below) so you can be sure later on which frame is your target frame.

oy y:
g A2/ + O @
e ¢
‘Working Zone: Start : 1 Duration : 151
Position : 73 Speed : 100% )

W W W W W @

Below is a picture of what it will look like once you selected the target frame as a key
frame.

From now on, you can go directly to the target frame by clicking on the image (shown
with the red arrow).

l« @& [

‘Working Zone: Start : 1 Duration : 151

Position : 73 Speed : 1003

W S 5 W W &

10
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3. Set the playback speed to the slowest speed possible (Speed Control marked with red
rectangle below), so it is easier to work with each frame.

2L 1 e ®
‘Working Zone: Start : 1 Duration : 151
Position : 73 Speed : moxl - {H) + I

W WY wWww 2

4. Use the Player Control button (marked with red rectangle) to select 5 frames before
the target (target frame is the 6" frame)

[ 1 « ©&
‘Working Zone: Start : 1 Duration : 151
Position : 73 Speed :5% — &

WIWIW W w 2

5. After you find the 5 frames before the target frame, click on Start Working Zone
(marked with red rectangle) to set the first frame of the working zone.

1 &« ©f
‘Working Zone: Start : 1 Duration : 151
Position : 73 Speed :5% — &

W WY wWww 2

6. Go back to the target frame by clicking on the image (see #2 above), and again using
the Player Control button (marked with red rectangle), select 4 frames after the target

frame.
201 e ®
‘Working Zone: Start : 1 Duration : 151
Position : 73 Speed :5% — &

U

W VW V| W W

11
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7. Then click on the End Working Zone (on the right as indicated below by the red
rectangle) to set the last frame of the working zone.

a1 DN &
YWorking Zone: Start : 1 Duration : 151

Position : 73 Speed :5X - 5

W W WY W w 2

Below is the picture of what the screen should look like after you finish selecting the
Working Zone. Scroll back to the beginning and click on Player Control (see step #6);
every click will bring you to the next frame in the movie. Check the Position, which tells
you in what frame you are at in the working zone, as you click through the frames in the
working zone with the Player Control. The movie should start with “Position 1" and end
with “Position 10,” as there should be 10 frames total in the working zone.

[ 1 I (2 —_

YWorking Zone: Start : 68 Duration : 11

am
W Speed : 5% - B

W WYY wWw 2
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How to display speed of tracked object

Step 1 - After tracking the path of your object, return to the first frame by clicking the *»’
button.

Step 2 - On the first frame, right click the E that marks the desilred tracked object.

201 @
Werhing Zoow: Stet . 2.00.00.00 Duaatin 0080014

Step 3 - A scroll menu will appear after rig

| Configuration I

Restart Path Edition

ht clicking, then select “Configuration.”

Delete Path after this Paint
Delete all the Path

Step 4 - A selection menu will appear. Click the arrow next to “Measurement” and select
“Speed.”

13
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Configure Path

Configuration

o (®) Complete Path

( (O Path section around current image

5D O Label following the Path

Label: Label

Measurement: MNon

None
Distance

Appearance

Color : - Style : —

Cancel

Step 5 - Click “Apply” and the speed will now be shown next to the object in each frame.

14
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Setting the origin and adjusting axes

The coordinates in a movie are vital to calculate where the object is located relative to
other objects also in the video. The coordinates can also serve to calculate velocities in the
x-axis and y-axis direction. To do this, begin by recording a video:

1) Open the Kinovea program

@® MOTION TUNER

inoveQ

2) Here we have the action of throwing a paper plane.

3) Record action with a compatible video recorder.
Acceptable formats include: AVI, MPG, MOV, WMV, MP4, MKV, VOB, 3GP, MOD, TOD.
4) Upload video into Kinovea by locating file on your computer. (Shown by red arrow)

File Edt View Image Mol
vl | % shotats| @

Folders: (
(& Desktop

- 'g My Computer

# Recycle Bin
#{2) Adobe Premiere Elements
#{2) Encoded Files

) Lavouts

) videostuffemunoz

Video Files:

@1

© emunozvIDO0E03

@ cmunozvIDO0E04

@ CXMUNOZawesomepaperflight

5) Once the video is imported click on the Image tab. (Shown by red arrow)

15
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File  Edit View | Image i Options  Help
© Explorer | & Shy Deinterlace Ctr+D

Image Format »
Folders:

(&} Desktop
(- g My Computer
# Recycle Bin
1) Adobe Premigf
{5 Encoded File:
1) Layouts
() videostuffemy

Mirror Ctrl+M

Coordinates system origin
Grid Ctr+G
Perspective Grid Ctrl+P

|~

|
Video Files:

@1
@ cmunozVID00B03
@ cmunozVID00B04
@ CXMUNOZawesomepaperflight

6) Scroll down and select Coordinates system origin. (Shown by red arrow)

File Edit View | Image | Motion Options Help

Explorer | & Shy Deinterlace Ctrl+D
Image Format »
Folders:

Mirror Chrl+M

@

"¢ My Computer
2 Recycle Bin

{) Adobe Premie

#{2) Encoded File:

1‘,3 L'ay outs Coordinates system origin
) videostuffem

Grid Ctri+G

Perspective Grid Ctrl+P

< | =
¥ideo Files:

o1

@ cmunozvIDO0OBO3

@ cmunozy|DO0B04

@ CXMUNDZawesomepaperflight

7) Window will pop-up named Set coordinates system origin.

Set coordinates system origin @

I Apply I [ Cancel ]

8) Place cursor (shaped as crosshairs ﬁ;? ) where the origin is to be fixed. Once placed, select the
point by a mouse click (Shown by red box).

16
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Set coordinates system origin =

l Apply ] [ Cancel l

9) Select Apply. Now when data is recorded or exported into an Excel file, coordinates will be

relative to the selection made in the previous slide. X-component and Y-component velocities
may be calculated using this data.

Wt lmnd  Femie  Oda G Vew  hosa

o TR

»
- | warte i) z:..m D )
BrUc LA EEW R

g

9 | Coordinates (y: cm; t: time seconds) [velocity)

10 |« t t # component veloci y component velocity  Total Velocity

1 -0.22  -19.33 0:00:00:00(1)

12 -0.22 -19.33 0:00:00:01(2)  0.01666667 0 0

13 -743 0 -18.21 0:00:00:03 (3) 0.05 837 336 90.192234!
14 -427 1635 0:00:00:05(4) 0.08333333 948 55.8 110.003091
15 -0.37 1542 0:00:00:08(5)  0.116E66E7 1" 279 120.28054
18 427  -15.42 0:00:00:08 (€] 0.15 139.2 0 13¢
17 799 -16.91 0:00:00:10(7) 018333333 e -44.7 120.21917:

17
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How to set the calibration scale for distance measurement

1. Open a movie clip by left-click on File from the top -> Open Video File. Select a movie that
you want to work on.

5 o i
ki

2. Have an actual measuemt of referenc in the clip. In an exale shown, a blue paper
was the reference (22.86 cm x 30.48 cm).

3. Left-click on “Line” _Z_from the bar under the movie frame.

N E AL/ +p0O @y,

¢
a0 1 e ©

Srart - NANAAAN eatian - A-ANNTRE

4. Draw a line by left-click on one point of the reference and drag to the other point. You
can adjust it more accurately by zooming-in (Ctrl + Scroll Wheel with the cursor on the
movie screen).

18
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5. Left-click on the line drawn to select. Then, right-click on the line to open the menu. Left-

Click on “Calibrate Measure”.

Color and Size...

Persistence...

Display Measure

Calibrate measure...

Go to Key Image

Delete

6. Enter the value of the actual measurement for the reference in a left box (Here, we use
30.48). Make sure you select a right unit from drop-down bar (Here, we use “cm”). Then
Left-click on “Apply” button.

4

Calibrate measure
Configuration

Real size of the segment :

7. Finished! Every measurement in the movie is now calibrated!

19



Correction to auto tracking © 2011 Dr. Catherine Loudon and students

Correction to auto tracking

For movies that are not perfectly clear or crisp, the Auto-track option on Kinovea tends to
lose the object tracked and present an incorrect path. To fix this you must manually fix the
auto-tracking and here is how:

To begin Auto-tracking:

1) Right click on the object you want to track

a. Select “track path”
2) Moving the movie forward using the “play” button (marked by red box below). This will allow
Kinovea to auto- track the selected object through the rest of the clip

W W W W w 2

These figures show an example of the inaccurate auto-tracking using the “play button”:

Figure 1: Here you can see the
original track point is set on the
wrist and the tip of the plane

Figure 1:

Figure 2:

Figure 2: Due to the unclear image,
you can see that the tracking marker
has lost both the wrist and the tip of
the plane and slipped to a different
part of the figure

20
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Figure 3: Figure 3: At the end of the motion,
we can see the auto tracked path
is clearly not the tracked path of
the object we originally marked

To fix this incorrect tracking:

1)

2)

3)

4)

5)
6)

Right click on the object you want to track

a. Select “track path”
Instead of moving movie forward by pushing play button, instead use “go to next frame” button
(Indicated by red box below)

W W W Ww 2

- This way you will be able to access the placement of the tracking marker for each frame

If the tracking marker has moved from your original placement and you will need to readjust
a. Todo this, right click on the tracking marker and select “restart path edition”

This will bring up a marker. Left click on this symbol and you can drag the + to the point

which you originally tracked. After placing the + in the correct position on the selected object,
the tracked path will be automatically corrected to the placement of the marker which you
choose.

Continue this process through all of the frames which you wish to track.

After you have finished adjusting the auto track for all frames, you can go back to beginning and
push the “play” button to view the corrected tracked path.

These figures show an example of the previous incorrect auto-track shown above fixed
using the technique just described:

21



Correction to auto tracking

Figure 4:

Figure 5:

Figure 6:

© 2011 Dr. Catherine Loudon and students

Figure 4: Here we have chosen the
same points as we did in the
previous example

Figure 5: Here the auto track has
been corrected and placed on the
original points which were
selected

Figure 6: Here you can see the
corrected auto-track path is a
much better representation of the
movement of both objects

22
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Exporting Data to Microsoft Excel
1. Exporting data
Once you have defined your numerical data (i.e. tracking data) you can export the data in

Kinovea using the menu under File > Export to Spreadsheet > Trajectories to simple
text.

[Fie | Edt view Image Motion Options Help
I Open Video File... Ctrl+0 i 9 Copy of andrewvd_egor ball MP4

Recent »
Close =
Save... Ctrl+s ‘
Export to Spreadsheet » | OpenOffice Calc (ODF)
Load Key Images Data... Microsoft Excel {(MS-XML)
Quit KHTML

| Trajectories to simple text

Then save your file. This will save the file in the format, “.txt”
2. Import data to Excel

Open the excel file that you would like to import the data to. Using the menus under Data
tab, click on “From Text” located in the “General External Data” box.

O\ 9 -~ ¥ Bookl - Microsoft Excel
s |
- Home Insert Page Layout Formulas Data Review View Acrobat
3 & N Y - J |G3] connedtions || E & Clear
=) = | [ Al Az ? E_%
_l/r" —0 —-J —U —U (R 3" Properties Zi2 ‘:" Reapply -
From From | From |From Other Existing Refresh %l Sort Filter v Textto Remove
Access Web | Text | Sources~ | Connections All~ =2 Edit Links 7 Advanced || Columns Duplicates V.
| Get External Data Connections Sort & Filter
Al | Get External Data From Text
A Import data from a text file. | E F | G | H | | | J | K

; @ Press F1 for more help.
3
4

Then a window will prompt asking you to locate the required file. Locate your saved file
from Kinovea and click “Import”

23
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The “Text Import Wizard” window will prompt and guide you through on the
specification of how you would like to import the file.

Text Import Wizard - Step 1 of 3

The Text Wizard has determined that your data is Fixed Width.
If this is correct, choose Next, or choose the data type that best describes your data,
Original data type

Choose the file bype that best describes your data:
it - Characters such as commas or tabs separate each field.

- Fields are aligned in columns with spaces between each field.

Start import at row: |1 % | File grigin: 437 1 OEM United States v

Preview of file E:\Bio Sci E131L\Lab 3\andrewvd_egor plane_both.txt.

1 fKinovea Trajectory data export Ra
[zl x v

:00:00:00 46.97 54.96 B
:00:00:03 §0.57 56.21

:00:00:06 54.96 57.31 v

Click “Next”. This will lead you to step 2 of 3 in the wizard. In step 2, you can manually

adjust the column breaks if needed.

Text Import Wizard - Step 2 of 3 @

This screen lets you set field widths (column breaks).
Lines with arrows signify a column break.

To CREATE a break line, click at the desired position.
To DELETE a break line, double click on the line.
To MOVE a break line, click and drag it.

Data preview

0 20 30 40 50 60 70
L L L 1 L 1 L H s 1 s 1 s f
ZS *
Kinovea Tpajectpry data export 2
TXY
:00:00:00( 46.97| 54.9¢6 W
:00:00:03] 50.57 56.21
:00:00:06] 54.96| 57.31 v

[ Cancel ][ < Back ]| Next > |[ Finish l

Press “Next” and you will be led to the last step of the wizard.

24



Exporting data to Microsoft Excel © 2011 Dr. Catherine Loudon and students

Text Import Wizard - Step 3 of 3 D

This screen lets you select each column and set the Data Format.

X

Column data format

@ General
'General' converts numeric values to numbers, date values to dates, and all
O Text ~ remaining values to text.

-

© Do not import column (skip)

Data preview

neral

ry data export ol

54.96 F

§6.21

§7.31 v
>

In step 3, you can adjust the format the data if desired. Otherwise, click “Finish.” The
file is now successfully imported into Microsoft Excel.

"9
Home Insert Page Layout Formulas Data Review
- [3] connedtions || 5
o @ [%F Properties 2
From Refresh — zl
Acce! Nel A~ =2 Edit Link
Connections
[ Al - fe | #Kinovea T
A B Cc D E E
1 #KinoveaT!rajed ory data export
2 HTXY
3 0:00:00:00 46.97 54.96
4 0:00:00:03 50.57 56.21
5 0:00:00:06 54.96 57.31
6 0:00:00:09 60.12 57.93
7 0:00:00:13 65.6 58.24
8 0:00:00:16 68.73 58.09
9 0:00:00:19 714 57.93
10 0:00:00:23 71.71 55.74
11 0:00:00:26 714 54.33
12 0:00:00:29 69.99 52.76
13
14
15 0:00:00:00 46.03 70.14
16 0:00:00:03 49.95 71.87
17 0:00:00:06 54.96 73.12
18 0:00:00:09 62.79 74.84
19 0:00:00:13 70.77 76.41
20 0:00:00:16  79.23 77.82
21 0:00:00:19 86.9 78.76
22 0:00:00:23 94.41 79.54

23 0:00:00:26 101.9 3 80.16
24 0:00:00:29 108.8 280.48

25
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Different ways to save your Kinovea projects

1. Use menu File — Save or use the toolbar’s “Save” button.
2. You will have 4 options:
a. Save video only
b. Combine video and key images data in the file
C. Permanently paint key images data on the video
d. Save only the key images data
3. Saving a file means preserving your selected working zone, current slow motion

value and other preferences.
4. Supported output formats include MKV (Matroska), MP4, and AVI.
5. Supported codec for output is MPEG4-ASP (which is DivX/Xvid compatible).
6. If key images data were added to the video, by default it will save as option “b”
above, Combine video and key images data in the file.
a. This method separates the original images from the key images data within
the same file.
b. Opening this type of saved file in Kinovea allows you to modify your
drawings, stopwatches, paths and comments.
C. Opening this type of saved file in another program only allows you to view
the original images.
7. If you desire to export your video so that your drawings, stopwatches and paths are
visible if opening the video using another program, use option “c” to save the file,
Permanently paint key images data on the video.
a. However, your written comments on the key images will be lost.
8. To save only the original, raw images then select option “d,” Save only the key
images data.
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Tracking the speed of an object

Step 1: Selecting an object to track

Right click on the point/object in the digital video that you want to track and click “Track Path”
A blue box with a crosshair will appear over the object. We can use this later to correct for the
desired object path for analysis.

Track Path
Set Original Speed..

Save the Current Image to File

Close This Screen

Step 2: Tracking and correcting the object movement path

Allow the Kinovea program to automatically track the path of the object by viewing the video frame
by frame, using the keyboard arrow buttons (right or left arrows) to move through the video. You
may correct errors in the automatic object tracking by dragging the blue crosshair box to the
correct path and position during each frame of movement for the object.

r‘

(Drag from the small blue crosshair to the
point desired.)

Step 3: Calibration

In order to measure the speed of the object, we must calibrate the scale of the video with a
reference sized object. In this example, we used an A4 sheet of letter paper to calibrate (30.48 cm in
width). Make sure the plane of the reference material is parallel to the camera lens for maximum
accuracy in your measurements.

First we create a solid line on top of a reference length in the video. Press the “line” button on the
bottom taskbar and it allows you to drag a neon green
line from point to point (Hold, and release button at

—
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the end) in the video.

Next, right click the created line and click on “Calibrate measure...” then fill in the real size of the

indicated segment in the desired units.

’-

Calibrate measure

Color and Size...

= Configuration
Persistence...

Real size of the segment :

Display Measure s
play 30.48 | Centimeters (cm)

Calibrate measure...

)

\ Apply | {

Cancel ‘

Delete

Step 4: Configure measurement for speed

Right click the tracked path, click “configuration”, and set the measurement for “Speed”.

Label : Label
— Configuration N
Measurement: INONE|
End Path Edition . -
None
Delete Path after this Point Distance
Delete all the Path Appearance Speed

Step 5: Measuring speed and exporting data

First, replay the video with the entire tracked path so that Kinovea
will calculate the speed of the tracked object in each digitized frame.
The speed of the tracked point is shown in the blue box in each
successive frame, following the small black and white roundel.

4.97 mis

Export the data by clicking “File>export to Spreadsheet” and then

choosing the desired export format. The current Kinovea version
0.8.7 exhibits incompatibility with some user system
configurations when exporting to Excel (MS-XML) format due to
the recent changes by Microsoft to its original “xls” format, so we
recommend the majority of users to export desired data to
XHTML format. The XHTML formats are opened with any current
web browsers (i.e. Firefox, Google Chrome) and then relevant
data can be copied into Excel, with spreadsheet formatting kept
intact due to the transposable nature of XML structured data.

[ File

Edit View Image
Open Video File... Ctrl+0O

Recent

Close
Save... Ctrl+S
Export to Spreadsheet

Load Key Images Data...

Quit

Motion

Options  Help

»

OpenOffice Calc (ODF)
Microsoft Excel (MS-XML)
XHTML

Trajectories to simple text
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